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Introduction 
 

The National Association of State Units on Aging (NASUA), with funding from the 
Administration on Aging (AoA), has engaged a third-party vendor to develop a 
software reporting structure for the State Program Report (SPR) section of the 

National Aging Program Information System (NAPIS). 
 

This effort was initiated to accomplish three primary tasks: 
 

1. Reduce SUA reporting burden, i.e., client detail information, system 
edits, validity checks and requirements for transmission. 

2. Incorporate required information regarding the National Family 

Caregiver Support Program. 
3. Comply with Office of Management and Budget (OMB) reporting 

requirements regarding reporting classifications, e.g., race and 
ethnicity. 

 

The resulting system is the NAPIS State Reporting Tool (NAPIS SRT). NAPIS SRT 
will help State Units on Aging to create, edit and validate SPRs and to create 

transmission files for submitting data to AoA. Through this project, NAPIS SRT 
will be provided to all State Units on Aging free of charge. Training on use of the 
system will also be provided to SUAs as part of this project. 

About NAPIS SRT 
 

NAPIS SRT offers several features that make preparing program reports faster 
and easier. 

 
 XML, Excel and DBF Import – many database systems can export to 

XML, Excel and DBF files.  Import files destined for NAPIS SRT need to 
conform to the appropriate schemas supplied by AoA. 

 Efficient report data entry – the data entry screens are based on the 
paper based SPR. 

 Use the SRT’s powerful roll-up report functionality to create a single, 

state report based off of multiple agency reports. 
 Error correcting tools – NAPIS SRT offers several tools to help you 

clean up data for submission. 
 Flexible print options – print out one or more sections of the report of 

the whole report quickly and easily. 

 Easy submission – NAPIS SRT supports one-click automated report 
submission. 
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About the Documentation 
 

The goal of the documentation is to describe the procedures and provide any 
extra information you will need to use the program. In the case of the printed 
manual, the documentation was not meant to be read cover to cover. If you are 

comfortable using the Windows® operating system, skip to Using NAPIS SRT 
for an outline of how to use the software. 

 

System Requirements 
 

 Windows 7 or Windows XP SP3 

 Internet Explorer 7, 8 and 9 
 2.0 GHZ processor or better 

 40-45 Kbps (kilobytes per second) 
 

Working in NAPIS SRT 
 

Working in NAPIS SRT describes screen features and basic procedures, including 
starting and exiting the program. 

 
If you are comfortable using Windows® based programs, you will probably want 
to skip most of this section.  

 
If you are not confident in using Windows or are new to using a computer, read 

through most of this section. It should help you better understand how to work 
in NAPIS SRT. 
 

Using NAPIS SRT contains step-by-step procedures on how to create, edit, and 
submit reports. 

 

Start and Log In 

 

 To start and log into NAPIS SRT 

 
1. From the Windows Start menu, select Programs (or All Programs in 

Windows XP) then US Administration on Aging, then SRT.  

2. Your computer displays the NAPIS SRT Log In screen. 
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3. Enter your Username and Password 

4. Click Login to start the program. 
5. After you have logged into the application you will be presented with 

the Select Reporting Module screen. 

 

 
 

 If you are creating a State Report click on State Program Reports 

button. 
 If you are creating a ARRA Report click on the ARRA Reports button. 

 

 
Working in NAPIS SRT describes screen features and basic procedures, including 

starting and exiting the program. 
 
The goal of the documentation is to describe the procedures and provide any 

extra information you will need to use the program. In the case of the printed 
manual, the documentation was not meant to be read cover to cover. If you are 

comfortable using the Windows® operating system, skip to Using NAPIS SRT 
for an outline of how to use the software. 
 

Data Tabs 

 

NAPIS SRT uses four main header tabs to display program reports. The tabs 
organize information so that you can find what you are looking for quickly 

amidst lots of information. When you click on the section header tab, individual 
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sub section tabs display below the section header tabs.  Click on a sub section 

tab and data entry tabs display. 
 

 

 
 

Working in NAPIS SRT describes screen features and basic procedures, including 
starting and exiting the program. 
 

Menus 

The NAPIS SRT menus are located directly below the AoA Reporting title 

bar. Menus give you access to functions of the program. NAPIS SRT 
contains these menus: File, View, Report and Help. Other menus appear 

as you access different areas of the program 

 

 
 

Toolbars 

The NAPIS SRT menus are located directly below the AoA Reporting title 

bar. Menus give you access to functions of the program. NAPIS SRT 
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contains these menus: File, View, Report and Help. Other menus appear 

as you access different areas of the program 

 

 
 

Moving Between Fields 

Use the UP ARROW and DOWN ARROW on the keyboard to move between fields. 
The ENTER key moves you to the next field. 

Shortcut/CTRL Keys 

Some frequently used NAPIS SRT menu options have shortcut keys, which are 
displayed to the right of the option. These shortcut keys can be used to access a 

function without having to open a menu. For instance, to save without using the 
mouse, hold down the CTRL key while pressing the S key. 

ALT Keys 

All menus and option buttons in NAPIS SRT have labels with one letter 

underlined. If the ALT key is pressed in combination with the underlined letter, 
the effect is the same as clicking the menu or button with the mouse. For 

example, the File menu can be opened by holding down the ALT key while 
typing an F. Use ESC for Cancel and Close. 

List or Grid Screens 

NAPIS SRT displays program reports in a List Screen. List Screens, also known 
as Grids, display several records in a list, similar to a spreadsheet. Each row 
contains one record. Columns divide each row, listing key information about 

each record. To open a record, double click the row of the entry. 

Sorting Information 

You can sort the records in a list screen by clicking the column headings. Click 

the appropriate column heading once to sort the records according to the data 
that appears in that column. The program sorts in ascending order by default. 

Click the same column heading once more to sort the information in descending 
order. 
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Refreshing List Screens 

Most list screens have a Refresh button. As you add or edit records, the records 
displayed by a list screen may not reflect the most recent changes to the 
database. When you click Refresh, NAPIS SRT updates the list screen with 

current data. 

Formatting Columns 

NAPIS SRT allows you to format the columns of the Report list (grid) screen. You 

can change the size and number of columns in view, the sort order of the data, 
and the order of the columns themselves. 

 

 To adjust column widths 

1. Hover the mouse over the right border of a column heading. 

2. When the pointer becomes a double-headed arrow, click and hold 
down the mouse button. 

3. Drag the column border to the left or right. 

4. Let go of the mouse button. 

 

 To adjust the column to fit the column contents 

1. Double-click the right border of the column heading. 

 

Changing List Screen Sort Order 

You can easily change the order of the data that appears on a list screen. 

 To change the sorting of a list screen 

1. Click the appropriate column heading once. The records sort 
themselves in ascending order according to the data that appears in 

the column. 

2. Click the same column heading once more to sort the information in 

descending order. 

 

Navigating the Report List Screen 

To navigate through the report list screen you will use Menu Bar which contains 
several buttons.  
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 Selection Module – takes you back to the main AoA Reporting page 
where you can select to run an SPR Report or an ARRA report  

 Back and Forward - used to navigate between pages.  

 New – used to generate a new report. 

 Open – used to open a selected report to view and edit contents.  

 Properties – displays contact information about the submitter and 
details about the selected report. 

 Delete – used to delete a selected report from the list view screen. 

 Print – used to print the list view screen. 

 Print Preview – used to preview the list view screen before printing. 

 Refresh – updates the list view screen with recent modifications.  

 Submit – submits your validated report automatically to the AoA. 

 Certify NSIP – allows state users to electronically confirm the validity 
of their NSIP numbers. 

 Certify SRP – allows state users to confirm the overall validity of the 
SPR 

 Fiscal Year – allows user to filter report list by fiscal year 

 Report Level – allows users to filter the report list by Agency or State 
reports. 

 Agency – allows user to filter the report list by submitting agency. 

 

Exiting NAPIS SRT 

 To exit NAPIS SRT 

1. From the File menu, choose Exit or click the X icon on the title bar. 

 

Using NAPIS SRT 

You can use NAPIS SRT to generate both annual (See “Annual Reports”) and 

Quarterly (See “Quarterly Reports”) Reports.  Process for creating and 
submitting both types of reports is very similar. 
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Quarterly report support American Recovery and Reinvestment Act (ARRA) 
reporting.  This section outlines the individual procedures used to create a valid 

report.  The checklist below describes the general process you will go through to 
get your quarterly and annual data ready for submission. 

 

NAPIS SRT Checklist 

 

1. Create a New Report (see "Creating Reports") 

2. Edit the report as needed to clean up data. 

3. Validate the data (see “Validating Data”) 

4. Correct any errors (see “Correcting Errors”) that the program has 
found. NAPIS SRT offers several error correction features including the 
ability to print parts or all of the report (see “Printing Reports”). 

5. Re-validate the report (See “Validating a Report”) 

6. Submit the Report (see "Submitting a Report"). 

 

Creating Reports 

NAPIS SRT creates two types of reports: State Reports and Agency Reports. A 

State Report is a report covering all agencies in the state which provides 
information on the effectiveness of social programs geared towards the elderly 
under the Older Americans Act. An Agency Report is a version of the State 

Report containing data for only one agency. You can run SPR reports based on 
annual data (see “Annual Reports”) and ARRA reports based on quarterly data 

(see "Quarterly Reports"). 

Reports can be created by using one of three methods: from a blank report, 
from agency "rollup" reports, and from an import.  This section looks at the first 

3 sections of report creation.  See Importing Reports for more information on 
importing from DBF, XLS and XML files (for either annual or quarterly reports). 

NAPIS SRT can copy developmental accomplishments in Section IV from one 
report to another. See Copying Report Accomplishments for details. Note that 
this only applies to annual reports. 
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Annual Reports 

AoA requires both annual SPR reporting and quarterly ARRA reporting. Annual 
Reports are much more detailed than quarterly reports and are submitted to 
AoA yearly. 

 

Annual Blank Program Reports 

You can create annual State Program Rollup or Agency Reports starting from a 

blank report.  If you’re importing files (See “Importing Reports”), NAPIS SRT 
creates a new report automatically based on the type of file you import. 

 

 To create a new annual blank program report 

1. Click the State Program Reports button or select State Program 

Reports from the View menu in the Select Module screen.  

2. Click the New button. 

 

 

 

3. Select Blank Report in the Report Source dropdown list. 

4. Under Fiscal Year, select the correct reporting Year.  The current year 
will default. 
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5. Submitter Name, Email Address and Phone Number will prepopulate 
with the user information.  This e-mail address is where your 
confirmation e-mails will be sent after submitting your report. 

6. Enter any comments, as needed. 

7. Indicate if you want to Copy Developmental Accomplishments? by 

placing a check in the box. 

8. Select the report that you want the Development Accomplishments to 
be copied from. Click OK after you have made the selection. 

9. Click OK. 

10. NAPIS SRT brings you to the Report Data Entry screen. Review 

information and change fields as needed. As you work, click Save 
periodically. 

11. Click the Save button to save the report. 

12. Use the Back button to navigate back to the main report selection 
page  

 

Annual State Program Rollup Reports 

NAPIS SRT can create annual State Program Rollup Reports by "rolling-up" or 

adding together several agency reports. When rolling up reports, the agency 
report date ranges must match those of the rollup report you are creating. 

 

 To create an annual state program rollup report 
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1. Click the State Program Reports button or select State Program 

Reports from the View menu in the Select Module screen.  

2. Click the New button. 

3. Select Rollup Report from the Report Source dropdown list. 

4. Enter a Report Name. 

5. Under Fiscal Year, select the correct reporting Year.  The current year 

will default. 

6. Submitter Name, Email Address and Phone Number will prepopulate 

with the user information.  This email address is where your 
confirmation emails will be sent after submitting your report. 

 

7. In the Reports screen, select the reports you need for the new rollup 
report. 
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8. Enter any comments, as needed, in the Comments section. 

9. Click OK. 

10. NAPIS SRT brings you to the Report Data Entry screen. Review 

information and change fields as needed. As you work, click Save 
periodically. 

11. Click Save and then the Back button to close the report. 

 

Quarterly Reports 

Quarterly reports support American Recovery and Reinvestment Act (ARRA) 

reporting. You are required to submit an ARRA Report to AoA four times a year.  
A Quarterly Report is considerably less detailed than the Annual Report, and 

looks only at the totals for Home Delivered and Congregate Meals found in 
Section II.A of the report. 

 

For more information about ARRA, visit: 

 

<http://www.recovery.gov/files/Initial%20Recovery%20Act%20Implementin 
g%20Guidance.pdf>. 

 

Quarterly Blank Reports 

You can create State Program Rollup Reports or Agency Reports quarterly 
starting from a blank report, or by importing xml or dbf files. If you are 

http://www.recovery.gov/files/Initial%20Recovery%20Act%20Implementin
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importing files (see "Importing Reports") NAPIS SRT creates a new report 

automatically based on the type of file you import. 

 

 To create a quarterly blank program report 

1. Click the ARRA Reports button or select ARRA Reports from the View 
menu in the Select Module screen.  

 

2. Click the New button 

3. Select the Blank Report from the Report Source dropdown list. 

4. Under Report Period, select the quarter you are reporting on. Quarterly 

time frames are as follows: 

 Q1: 10/1 - 12/31 

 Q2: 1/1 - 3/31 

 Q3: 4/1 - 6/30 

 Q4: 7/1 – 9/30 
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5. Submitter Name, Email Address and Phone Number will prepopulate 

with the user information.  This e-mail address is where your 
confirmation e-mails will be sent after submitting your report. 

6. Enter any comments, as needed, in the Comments section. 

7. Click OK. 

8. NAPIS SRT brings you to the Report Data Entry screen. Unlike annual 

Reports, quarterly Reports contain very little data - the only sections 
you can enter data into are the Home Delivered and Congregate Meals 

lines found in Section II.A of the report. All other fields have been 
disabled. Within these areas, you can review information and change 
field entries as needed. As you work, click Save periodically. 

 

 

9. When you have finished entering and reviewing data, validate the 
report.  Just as with annual reports, the SRT can validate quarterly 

reports at the cell, section, or report level. However, since there are 
only six fields on one page, it makes the most sense just to validate at 

the Report level (See “Validating Report”). 

 

To successfully validate a report, remember that a report cannot 

contain all zeroes.  Additionally, if you enter a number in any field in 
either the Home Delivered Meals or Congregate Meals rows, you must 

also enter numbers in the other two fields of that row. 

10. Click Save and then the Back button to close the report. 
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Quarterly Rollup Reports 

NAPIS SRT can create Quarterly Reports by "rolling-up" or adding together 
several agency reports. When rolling up reports, the agency report date ranges 
must match those of the rollup report you are creating. 

 

 To create a quarterly state program rollup report 

1. Click the ARRA Reports button or select ARRA Reports from the View 
menu in the Select Module screen.  

 

 

 

2. Click the New Button.  

3. Select Rollup Report from the Report Source dropdown list. 

4. Enter a Report Name 

5. Under Fiscal Year, select the correct reporting Year.  The current year 
will default. 

6. Under Report Period, select the quarter you are reporting on.  
Quarterly time frames are as follows: 

 

 Q1: 10/1 - 12/31 

 Q2: 1/1 - 3/31 

 Q3: 4/1 - 6/30 

 Q4: 7/1 - 9/30 
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7. Submitter Name, Email Address and Phone Number will prepopulate 

with the user information.  This e-mail address is where your 
confirmation e-mails will be sent after submitting your report. 

8. In the Reports screen, select the reports you need for the new rollup 

report.  Only items from the specified quarter are eligible for rollup. 

9. Enter any comments, as needed, in the Comments section. 

10. Click OK. 

11. NAPIS SRT brings you to the Report Data Entry screen. Review 

information and change fields as needed. As you work, click Save 
periodically. 
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12. Click Save and then the Back button to close the report. 

 

Copying Report Accomplishments 

You can copy developmental accomplishments in Section IV.A and IV.B from an 
existing report into a new report. NAPIS SRT cannot copy developmental 

accomplishments into an agency roll-up report. 

 

 To copy developmental accomplishments 

 

1. Click the State Program Reports button or select State Program 
Reports from the View menu in the Select Module screen.  

2. Click the New button. 

3. Choose a report following process described earlier in this 
documentation. 

4. Place a check mark in the “Copy Developmental Accomplishments” 
field. 

5. Click OK. 

6. Select the report you’d like to copy accomplishments from. 

7. Press OK. 

8. NAPIS SRT brings you to the Report Data Entry screen. 
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9. Begin data entry as outlined in Report Data Entry. 

 

Editing Reports 

If you edit a report that has been Validated, you will need to re-validate the 

report (see "Validating a Report") after saving your changes. 

 

 To edit an existing report 

1. Click the State Program Reports button or select State Program 
Reports from the View menu in the Select Module screen.  

2. Highlight the report you’d like to edit. 

3. Click Open on the toolbar. 

4. NAPIS SRT brings you to the Report Data Entry screen. 

5. Begin data entry as outlined in Report Data Entry. As you work, click 
Save periodically. 

6. Click Save and then the Back button to close the report. 

 

Report Data Entry 
 

NAPIS SRT uses clean, efficient spreadsheet-like screens for most of the data 

entry into an SPR. The look of the sections is based on the paper-based SPR 
report.  The sections of a program report are organized by Title and Section. 

 

To begin data entry, click on the section header tab, by default the “Section I” 

will be active and sub tabs associated with that section will be displayed. You 
cannot enter data into most Section Headings. They are there to organize the 
data entry sections within the report and to display your progress. 

 

A check mark icon on a tab means that the area has been validated. A blank 

icon indicates that either the section has not been entered or all changes to that 
section have been saved, but not validated.  

 

Each section contains one or more sub tabs, based on the paper version of the 
SPR. You enter data directly into these tabs. After highlighting an appropriate 

tab, NAPIS SRT displays the Data Entry Cells. Highlight a Data Entry Cell. Use 
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your keyboard to enter the number or text. Use the ENTER key or the RIGHT 

arrow to move onto the next cell. 

 

 

After validating the data, (see "Validating Data") NAPIS SRT displays any 
errors in the Errors pane in the lower portion of the screen. Double click on the 

Error Description and the data cell will be highlighted.  

 

Moving Through a Report 

The SPR has many sections and subsections. NAPIS SRT offers multiple tools to 

move through an SPR as efficiently as possible. 

 

NAPIS SRT displays the Navigation Tabs just above the Report Data Entry 

screen. 
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Entering Data into Cells 

 

 To modify numbers or data within a section 

1. After creating a new report (see "Creating Reports") or accessing 

an existing report, (see "Editing Reports") find the appropriate 
section and section with the cell you need to enter or modify. 

2. The screen defaults to showing you the first section. Click on a 
different tab to see a different section.  

3. The data entry cell of the section appears below the tabs. 

4. Click a cell. Enter or modify information as needed. Press ENTER or 
use the RIGHT ARROW to continue moving through the cells. 

5. When finished, click Save or to exit the report, click Back button. 

Validating Data 

Before your SPR can be submitted to the AoA, it must be Validated. The 

Validation process checks to make sure that a series of rules about the data in 
the report have been followed. 

 

NAPIS SRT validates data at three levels: cell level, section, and report level. 
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Cell Level Validation 

Cell level Validation validates just the cell that is currently selected in the Report 
Data Entry screen.  Highlight a cell and press the Validate Report button on the 
toolbar to have the data within that cell be validated. 

Section Level Validation 

Section level Validation validates just the current Section displayed in the Report 
Data Entry screen. Use the tabs to navigate to a particular section in a program 

report. Once you access and have filled in data within the appropriate section, 
click Validate Section NAPIS SRT validates the current section and provides a 

list of any errors. See Validating a Section for detailed instructions. 

Report Level Validation 

SPRs need to pass Report Level Validation before receiving a signature for 
submission to the AoA. To validate a report, open the report from the Reports 

list screen and click Validate Report.  NAPIS SRT checks all the data in the 
report. Several required sections of the SPR must have data and be error free 

before it can pass report level Validation. For more details on report Validation, 
please see Validating a Report. 

 

 

 

Validating a Section 

When you validate a section within a program report, an Error pane appears in 

the lower right of the screen. Numbers in any cells related to the errors change 
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color. You can customize the colors that NAPIS SRT uses for error cells. See 

Changing Report Colors for more details. 

 

 To validate a section within a program report 

1. Open an existing report. 

2. Navigate to the appropriate Section in the Navigation pane. 

3. Highlight the section so that NAPIS SRT displays it below the tabs. 

4. Click Validate Section on the toolbar. 

 

5. NAPIS SRT displays any errors in the Errors pane displayed below the 

Work pane.  

6. Double click on the description of the error and the data entry cell will, 

highlight where the error is in the section so you can make the 
correction. 

7. If the section was successfully validated, a check appears on the 

appropriate section tab. 

 

Validating a Report 

Even if you have validated each section within an SPR, you still need to validate 
the whole report to be able to submit your report to the AoA. If you have not yet 

entered data into certain parts of the report, Validate skips over non- required 
sections with all zeros.  
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When you validate a program, an Error pane appears in the lower portion of the 
screen. Numbers in any cells related to the errors change color. You can 

customize the colors that NAPIS SRT uses for error cells. See Changing Report 
Colors for more details. 

 

All sections listed below must have values (non-zero) and be error free before 
NAPIS SRT can export the SPR to an SRT file ready for transmission. 

 

 I.A 

 II.A 

 II.B 

 II.C 

 II.D 

 III.A 

 III.B 

 III.C 

 III.D 

 

 To validate a report for submission 

1. Open an existing report. 

2. Click Validate Report on the toolbar. 

3. NAPIS SRT displays the Report Data Entry screen. It takes a minute or 

two for the program to validate the whole report. 
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4. NAPIS SRT displays any errors in the Errors pane displayed below the 
Work pane.  

5. Double click on the description of the error and the data entry cell will 
highlight where the error is in the section so you can make the 

correction. 

6. If the report was successfully validated, the program prompts you. 
Click OK at the prompt. Click Save and then Back to save and close 

the validated report. 

 

 

Correcting Errors 

After validating a report or section, you may see a list of errors that NAPIS SRT 
has found. In a report as complex as the SPR, it can be difficult to find which 
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piece or pieces of data are causing the problems. Try these ideas to help resolve 

report errors: 

 

 You can print out the errors in the Error pan if it makes it easier for you to 
read. When the Error pane is in view, press Print Errors from the toolbar. 

 Use the Error pane to easily move through the sections that are causing 

problems. Highlight an error double-click on it to go to the appropriate 
section. 

 If it's not easy for you to see which cells are causing problems, try changing 
the color of the error cells. See Changing Report Colors for details. 

 Try printing or exporting a section to see the data in a different format. See 

Printing a Section and Exporting a Section for detailed instructions. 

 

Printing Errors 

You can print the list of errors found in the Errors pane. 

 

 To print a list of errors 

1. Open an existing report. 

2. Click Validate Section or Validate Report on the toolbar. 

3. NAPIS SRT displays all errors found in the Errors pane. 

4. Click the Print Errors button on the top toolbar.  

5. Click Print to send the list of errors to your local printer 

 

Viewing and Editing Report Properties 

 To view and/or edit the properties of a report 

1. Navigate to the Reports list. 

2. Highlight the report you’d like to edit and press Properties. 
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3. The following fields are editable:  Fiscal Year, Submitter Name, Email 

Address, Phone number and Comments. 

 

4. When finished viewing or editing properties, click Save. 

 

Deleting Reports 
 

 To remove a report from NAPIS SRT 

1. Navigate to the Reports list. 

2. Highlight the report you’d like to edit and press Delete on the toolbar. 

3. At the prompt, click Yes to continue or No to cancel. 

 

Importing Reports 

NAPIS SRT can import reports from DBF, XLS, and XML files.  DBF, XLS and XML 
files allow you to import data into NAPIS SRT from an outside database via .dbf 
or .xml files in order to populate your annual or quarterly reports. 

 

 To import files into NAPIS SRT 

1. Navigate to the Reports list. 
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2. Press New on the toolbar. 

 

 

 

3. Choose DBF Import, XML Import or Excel Import. 

4. Once you choose a third party import option, the browse dialog will 
appear. 

 

 

5. Browse to the file using the browse dialog. 
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6. In the Import screen, select the file you want to import and click Open. 

7. Click OK at the prompt and the new report will be created, 
automatically populated with the data found in the file. 

 

 

Printing Reports 

NAPIS SRT can print individual sections from a report or the entire program 
report. When you click Print Report from within an open report NAPIS SRT 
brings you to the Print Report screen. Print Report allows you to determine 

which sections you would like to print. 

 

 To print out a report 

1. From within an opened report, press the Print button on the toolbar. 
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2. Use the plus buttons to expand the areas within the Print Report 

screen and select specific sections that you’d like to print.  If you’d like 
to print the entire report, press Select All. 

 

 

3. Select a Printer.  Change printer preferences as needed. 

4. Click Print and the sections you selected will be sent to your specified 

printer. 

 

Exporting Reports 

Use the NAPIS SRT export feature to export report data into Microsoft Excel® 
and other third party programs. Files created using the export feature cannot be 
imported by NAPIS SRT. 

 

Here's a list of the export options offered by NAPIS SRT: 

 

 Adobe Portable Document (.pdf) - a read-only format. PDFs are 

typically opened with Acrobat Reader. 

 MS Excel (.xls) - outputs formatted data to an Excel spreadsheet. 

 MS Word® - convert the section into a Microsoft Word document. 

 HTML 4.0 (.htm) - HTML stands for HyperText Markup Language. 
This is a file format primarily used for publishing to Web pages. 

 Rich Text File (.rtf) - a plain text file. 

 

 To export a report 
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1. From within an opened report, press the Export button. 

 

 

 

2. Select the specific sections that you’d like to export.  To export the 

entire report, press Select All. 

3. Press OK 

4. Select a file format in the screen that appears. 

 

 

 

5. Select a location to save the file. 
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6. Click Save. 

 

Submitting a Report 

You can only submit a report to AoA once it has been Validated. 

 

 To submit a report to AoA 

1. Navigate to the Reports list. 

2. Confirm that the report you want to submit had been validated by 

looking for a check in the Verified? column. (If your report has not yet 
been validated, see Validating a Report for instructions.) 

3. Highlight the report you want to submit, then click the Submit button 

on the toolbar. 

 

 

4. You will be prompted to confirm your report submission. Click Yes to 

continue. 

 

5. After submitting your report the Submitted checkbox will be filled in 
and you will receive an automated confirmation e-mail from AoA 
confirming that the report submission was received. The confirmation 

e-mail will be delivered to the e-mail address that was entered on the 
Properties screen when the report was created. To edit or add an e-

mail address prior to submitting, see Viewing and Editing Report 
Properties. 

 

 To re-submit a report to AoA 

1. Highlight the report you want to re-submit, then click the Submit 

button on the toolbar. 

2. You will be prompted to confirm that you wish to re-submit the report. 
Click Yes to continue. 
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3. After re-submitting your report you will receive an automated 
confirmation e-mail from AoA confirming that the report submission 

was received. The confirmation e-mail will be delivered to the e-mail 
address that was entered on the Properties screen when the report 
was created.  To edit or add an e-mail address prior to re-submitting, 

see Viewing and Editing Report Properties. 

 

Certifying NSIP Data 

NAPIS SRT gives state users the ability to certify that the NSIP numbers in their 
validated reports are correct.  After a State User certifies that the NSIP numbers 
are correct, a checkmark will appear in the NSIP Certified by State? column.  

When AoA certifies that the NSIP numbers in the report are correct, a 
checkmark will appear in the NSIP Certified by AoA? column.  NSIP data in 

reports that have not been validated cannot be certified. 

 

 To certify the NSIP data in a report  

1. Select a validated report from the List screen and click the Certify 
NSIP button on the toolbar. 

2. You will be prompted to confirm the certification of the NSIP data.  
Click Yes to continue. 

3. In the Certify NSIP screen that appears, check the I Agree checkbox, 

then enter Your Name, Your Title and any Comments.   
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4. Click Certify to complete the process. 

5. A checkmark will then appear in the NSIP Certified by State? column. 

Certifying SPR Data 

NAPIS SRT gives State users the ability to certify that the data in their validated 
SPRs are correct.    After a State User certifies that the data in the SPR is 

correct, a checkmark will appear in the SPR Certified by State? column.  When 
AoA certifies that the data in the SPR is correct, a checkmark will appear in the 

SPR Certified by AoA? column.  SPRs that have not been validated cannot be 
certified. 

 

 To certify the data in a validated SPR  

6. Select a validated report from the List screen and click the  Certify 

SPR button on the toolbar. 

7. You will be prompted to confirm the certification of the report.  Click 
Yes to continue. 
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8. In the Certify SPR screen that appears, check the I Agree checkbox, 

then enter Your Name, Your Title and any Comments.   

 

 

9. Click Certify to complete the process. 

10. A checkmark will then appear in the SPR Certified by State? column. 

 

Note:  The checkbox in the “Locked” column will be checked for report 

within fiscal years that AoA has locked down for editing.  If AoA locks 
down 2010, for instance, then any report submitted in 2010 will no longer 

be editable. 

 

User Customizations 
 
Users are provided with various tools that they can use to facilitate data entry. 
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Changing  Report  Fonts 

 

You can customize the fonts that NAPIS SRT uses in from within any opened 
report. 

 

 To change the font used in a program report 

 

1. In an open report, click Preferences  in the toolbar.  

 

 

 

2. Select the desired font form from the Font dropdown list. 

3. Select the style from the Style dropdown list 

4. Select the font size from the Size dropdown list. 

5. As you make your selections, the Sample window will display the 
changes. 

6. Click OK to save your changes. 
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Changing  Report  Colors 

 

You can customize the colors that NAPIS SRT uses in error messages from 
within any opened report. 

 

 To change the colors used in error messages 

 

1. In an open report, click Preferences  in the toolbar.  

 

 

 

2. Select the desired color from the Foreground Color dropdown list. 

3. Select the desired color from the Background Color dropdown list. 

4. As you make your selections, the Sample window will display the 
changes. 

5. Click OK to save your changes. 

 

 


